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WebEx 
Quick Reference Guide 
 
Layout Getting Started 

WebEx is a Web conferencing and videoconferencing solution that can be 
used to host webinars, peer-level Web meetings, and webcasts.  

 

 

 

 

 

Note:  Any employee (Humber or Guelph-Humber) assigned a personal 
extension can host a WebEx meeting at no additional cost.  WebEx supports up 

to 100 participants in meetings.  Log into the portal (myMeeting.humber.ca) 
using your business e-mail address and Humber password.  Anyone (including 
individuals without Humber credentials) can participate in WebEx meetings.   

Start by installing the WebEx plugin 
(one-time install per computing device) 

to integrate WebEx with Outlook.  
Alternatively, you can use the WebEx 

portal to manage all meetings.   

Step-by-step Procedure: 

1. Completely close down Outlook 
on your desktop/laptop. 

2.  Launch a browser instance, 
navigate to the address… 

myMeeting.humber.ca 

…and log in using your Humber 
e-mail address and password. 

3.  Click the Download button in 
the Productivity Tools section 
and allow the installer to run. 

 

4. Follow the WebEx Setup Wizard 
to install the tool. 

 

NOTE:  The installer will place a 
Meet Now and a Schedule Meeting 

button in the Outlook ribbon. 
 
5. When prompted, key the 

following address… 

myMeeting.humber.ca 

…into the WebEx Assistant. 

6. Log in using your Humber e-mail 
address and password. 

Joining a Meeting 

  

Joining a Meeting as a Participant 

1. Follow the meeting link in the e-mail/calendar invite.  
2. Accept the WebEx plugin (if prompted) and then key in your name.  
3. Select an audio (Call Me, I Will Call In, Call Using Computer) connection. 

Joining a Meeting as the Host 

1. Follow the link in the e-mail/calendar invite or log into the WebEx portal. 
2. Click the Start button (if prompted) to start the WebEx meeting. 
3. Log in (if prompted) using our Humber e-mail address and password. 
4. Select an audio (Call Me, I Will Call In, Call Using Computer) connection. 

NOTE:  Alternatively, you can log into WebEx (myMeeting.humber.ca) using 
your Humber e-mail address and password to join meetings you are hosting. 

Invite Call 

 

Share Screen 
Used to share a monitor or 
application with participants. 

 

Quick Start Tab 
Connect to audio, 
share your screen, 
or invite/remind 
participants. 

 

Chat Pane 
Used to send text-
based messages. 

Recorder Pane 
Used to record 
meetings. 

Participants Pane 
Used to manage 
participants. 

Invite & Remind  
Used to add participants or 
send an e-mail reminder. 

 

Audio Connection 
Used to establish an audio 
connection with a meeting. 

 

Whiteboard 
Used to help 
illustrate points. 

Leave Meeting 
Used to exit a 
meeting or bring a 
meeting to an end. 

 
 



 

Scheduling a Meeting 

Meet Now 

Using the Plugin in Outlook 
1. Open your Outlook mailbox or calendar. 
2. Click on Meet Now on the Home tab. 
3. Click on Invite & Remind in the WebEx window. 
4. Key in each participant’s e-mail address. 
5. Click the Send button to invite the participants. 

Using the WebEx Portal (Alternative Method) 
1. Navigate to the portal (myMeeting.humber.ca). 
2. Log in with your Humber e-mail and password. 
3. Click the Meet Now button. 
4. Key in each participant’s e-mail address. 
5. Click the Start button. 

Schedule a Meeting 

Using the Plugin in Outlook 
1. Open your Outlook mailbox or calendar. 
2. Click on Schedule Meeting on the Home tab. 
3. Schedule the event (subject, location, and time). 
4. Click on Invite Attendees to add participants. 
5. Click the Add WebEx Meeting button. 
6. Confirm the WebEx details.  Click the OK button. 
7. Click the Send button. 

Using the WebEx Portal (Alternative Method) 
1. Navigate to the portal (myMeeting.humber.ca). 
2. Log in with your Humber e-mail and password. 
3. Click the Schedule button. 
4. Schedule the event (what and when). 
5. Key in each participant’s e-mail address. 
6. Click the Schedule It! button. 

Editing a Future WebEx Meeting 

1. Open the meeting in your Outlook calendar. 
2. Add or remove participants as needed. 
3. Click the Send Update button. 

NOTE:  You can also edit WebEx meetings using the 
WebEx portal.  Log into the portal (myMeeting.humber.ca) 

using your Humber e-mail and password.  Select the 
meeting to edit in the Meetings tab.  Click the Edit button.  

Apply desired edits and click the Save button. 

Rescheduling a Future WebEx Meeting 

1. Open the event in your Outlook calendar. 
2. Adjust the event date and time as needed. 
3. Click the Send Update button. 

NOTE:  You can also reschedule WebEx meetings in the 
WebEx portal.  Log into the portal (myMeeting.humber.ca) 

using your Humber e-mail and password.  Select the 
meeting to reschedule in the Meetings tab.  Click the Edit 
button.  Reschedule the meeting and click the Save button. 

Cancelling a Future WebEx Meeting 

1. Open the meeting in your Outlook calendar. 
2. Click on Cancel Meeting in the Meeting tab. 
3. Click the Send Cancellation button. 

NOTE:  You can also cancel WebEx meetings in the 
WebEx portal.  Log into the portal (myMeeting.humber.ca) 

using your Humber e-mail and password.  Select the 
meeting to cancel in the Meetings tab.  Click the Delete 

button.  Confirm the cancellation by clicking the Yes button. 

Hosting a Meeting  
 
 
 
 
 
 
 
 
 
 

Reminding Participants of a Meeting 

1. Select the Quick Start tab. 
2. Click the Invite & Remind button.  
3. Select the Remind tab.  
4. Check the participants to remind. 
5. Click the Send Reminder button.  

Adding Last-moment Participants  

1. Select the Quick Start tab.  
2. Click the Invite & Remind button.  
3. Select the E-mail tab. 
4. Key in participant e-mail address.  
5. Click the Send button.  

Recording a Meeting 

Meetings can be recorded (audio and 
video) for playback at a later time. 

 

Select the Recorder panel.  Continue 
by clicking the Record button. 

NOTE:  Click the Pause button to 
suspend meeting recordings. 

Assigning Roles to Participants 

You can assign participants meeting 
roles.  1. Select a participant in the 

Participants panel.  2. Right-click and 
select the Change Role option.  3. 
Select a role (host, presenter, note 

taker, etc.) for the participant. 

NOTE:  Right-click your own name in 
WebEx and use the Change Role 
option to reclaim a delegated role. 
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Sharing a File 

1. Click on File in the 
Share menu. 

2. Select the file you 
would like to share. 

NOTE:  Each shared file 
appears as a WebEx tab. 
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Whiteboard 

Use the Whiteboard feature to illustrate your points. 

 

NOTE:  Click the Save button to save whiteboard work. 

Sharing Your Screen  

Sharing a monitor or application takes everyone out of the 
WebEx application interface and instead shows everyone 

everything the presenter sees on his or her computer. 
 
 
 
 
 
 

 
 

1. Select the Quick Start tab in WebEx.  
2. Click on More Options under Share Screen.  
3. Select a Monitor or an Application to share. 

NOTE:  Resources being shared have green borders.  
Click on Stop Sharing in WebEx’s toolbar to halt. 

Annotating Your Screen  

Annotation is a note (text or diagram) added by way of 
comment or explanation.  Click the Annotate button in 
WebEx’s toolbar to annotate resources being shared.   

 

NOTE:  Click on Assign in WebEx’s toolbar and select 
Allow to Annotate to enable a participant to annotate. 

Sharing Your Keyboard and Mouse 

1. Click the Assign button in WebEx’s toolbar. 

 

2. Select Pass Keyboard and Mouse Control option. 
3. Choose a participant to whom to pass control. 

NOTE:  Click anywhere on the shared monitor/application 
to regain control of your keyboard and mouse.  

Passing the Presenter Role to a Participant 

1. Select a participant in the Participants panel.   
2. Right-click and select the Change Role option. 
3. Assign the Presenter role to the participant. 

NOTE:  Right-click your own name in WebEx and use the 
Change Role option to reclaim the Presenter role.  

Notes 

Use the Notes feature to document your meetings. 

 

NOTE:  Click the Save button to save meeting notes. 

Chat 

Use the Chat feature for text-based messaging.  

 

NOTE:  Messages can be sent to one or all participants.   

Muting Meeting Participants 
As the host, you can mute meeting participants: 

Mute a Participant 
1. Select a participant in the Participants panel. 
2. Click the microphone icon to mute and unmute.  

Mute all Participants 
1. Click on Mute All in the Participant menu.  

NOTE:  Select the Unmute All option to cancel.  

IMPORTANT:  Consider using the Mute on Entry 
feature in the Participant menu to automatically mute 

all meeting participants as they join the meeting.  

Whiteboard 
Toolbar (Pen, 
text, line, shape, 
eraser, pointer) 
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Polling  
 Use the Polling feature to survey 

meeting participants.  You may pose 
multiple choice and short answer 
questions.  Results (responses) 
appear in real-time for all to see.   

Add the Polling Panel 

1. Click the View menu. 
2. Expand the Panels option. 
3. Click on Manage Panels. 
4. Add the Polling panel. 
5. Click the OK button. 

Create a Question 

1. Expand the Polling panel. 
2. Select a question type. 

 

 

3. Click the New button. 
4. Key in your question. 
5. Click Add to add choices. 

Polling Participants 

1. Click the Options button. 
2. Set the Timer and click OK. 
3. Click the Open Poll button. 

Start a New Poll 

1. Click the New Poll button. 
 

IMPORTANT:  You will have the 
opportunity to save both your 

questions and each poll’s results as 
you leave/end your meeting. 

Managing Behaviour 

One way to manage meetings is 
to ask attendees to “raise their 

hand” to be acknowledged. 

 

Participants can “raise their hand” 
by hovering over their presence in 

the Participants panel and 
toggling the hand icon. 

Leaving/Ending a Meeting 

Leaving a Meeting 

 

Leaving a meeting, even as the meeting’s host, does not 
end the meeting.  To leave a meeting, start by selecting the 

Quick Start pane.   Then, click the Leave Meeting link.  
Finally, confirm your intent to leave the meeting by clicking 

the Leave Meeting button.  Anyone leaving a meeting, 
willingly or otherwise, is free to rejoin said meeting later. 

Ending a Meeting 

 

Ending a meeting ends it for everyone.  Start by selecting 
the Leave Meeting link in the Quick Start tab.  If you 

recorded the meeting, put a check in the Share Meeting 
Recording with Invitees box to have WebEx e-mail all 

participants a link to said recording.   Confirm your intent to 
end the meeting by clicking the End Meeting button. 

Recordings 

You can easily find the recordings for all 
meetings you hosted in the WebEx portal: 

1. Launch a browser and navigate to the 
WebEx portal (myMeeting.humber.ca). 

2. Log into the portal using your Humber 
e-mail address and Humber password. 

3. Select the Recordings tab for a list of 
all recordings for meetings you hosted 

4. Use the Options dropdown to play, 
share, download, or delete a recording. 

NOTE:  WebEx also e-mail hosts a direct link 
to a meeting’s recording after a meeting ends.  
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Personal Conferencing 

WebEx can also be used for basic 
audio conferencing purposes thus 
eliminating the need for personal, 
third-party, conferencing solutions. 

Getting Started: 

1. Launch a browser instance, 
navigate to the address… 

myMeeting.humber.ca 

…and log in using your Humber 
e-mail address and password. 

2. Click on My Account for your 
personal WebEx settings.   

 

Continue by scrolling down to 
My Audio Connection Options 
and expanding the Personal 
Conferencing section. 

3. Note the local, toll-free, and 
internal extension numbers for 
the audio conferencing service. 

4. Key in a 4-digit code to use as 
your Host password.  Note that 
single-number and sequence-
based codes (example:  1111 
and 1234) are not acceptable. 

5. Click the Regenerate Access 
Code link to generate a set of 
WebEx audio conferencing 
credentials.   Keep your access 
codes in a safe place. 

IMPORTANT:  Never disclose 
your personal host access 

code or your host password.  
Should you forget any of your 
access codes, simply log back 

into WebEx and generate 
yourself new credentials. 

 Audio conferencing services are available through WebEx to all 
Humber and Guelph-Humber employees at no cost. 

 

 

 

 

 

 

 

Setting Up a Conference 

Setting up an audio conference 
(call) takes less than two minutes: 

1. Schedule the call with the 
needed meeting participants. 

2. Invite participants to call in using 
one of the following numbers… 

a. 416.673.6709 (local) 
b. 1.855.673.6709 (toll free) 
c. X6709 (internal) 

…at the time of the call.  

3. Supply your Participant Access 
Code to the call participants. 

Helpful Tip:  Consider sending both 
the telephone numbers and the 

Participant Access Code as part of 
a single calendar invite. 

Calling in as the Host 

1. Dial into the audio conference 
using one of the call-in numbers. 

2. Key in your Host Access Code 
followed by the octothorpe (#) key. 

3. Enter your 4-digit Host ID followed 
by the octothorpe (#) key. 

4. Finish by recording your name and 
pressing the octothorpe (#) key. 

Calling in as a Participant 

1. Dial into the audio conference 
using one of the call-in numbers. 

2. Key the Participant Access Code 
followed by the octothorpe (#) key. 

3. Finish by recording your name and 
pressing the octothorpe (#) key. 
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Regenerate Access Codes 
Used to generate a new set of 
audio conferencing credentials. 

Access Codes 
Used to identify the conference 
host and his or her participants. 

Telephone Numbers 
Used to dial into WebEx for 
audio conferencing purposes.  


